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A    newsletter is an effective way of sharing common
interests and exchanging news and ideas. Newsletters are a
fast-growing publishing trend and are used widely by large
corporations, educational institutions, local civic groups, and
even individuals.

Widespread newsletter production resulted from desktop
publishing popularity and accessibility of microcomputers.

Newsletters are usually confined to an 8.5-x-11-inch format, a
size well suited to desktop publishing programs. Normally, the
minimum number of pages is 4, and rarely does a newsletter
have more than 24 pages.

Newsletter production can be inexpensive and does not require
a large staff. A single person using a desktop publishing pro-
gram can easily perform all stages of publishing, including
editing, type creation, text formatting, and page layout.

Material presented in a newsletter looks professional and can
lend credibility to the publication. Desktop-published newslet-
ters are easier to read than are typewritten pages. Also, typeset
quality takes up less space, which means more information per
page and lower printing costs. Not only does typeset text help
make a newsletter more readable and convey more informa-
tion, but also desktop publishing lets you use typography
creatively to add special impact to certain ideas. The results are
pleasing to both the editor and the reader.

Newsletters are perceived
as a timely and reliable
source of information.

Normally, newsletters do
not contain advertisements.

Producing a newsletter at
school promotes student
teamwork and cooperation.

Azarmsa, Reza. Desktop Publishing for Eduactors: Using Adobe PageMaker. Allan & Bacan, 1999.
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Newsletter Elements
Newsletters come in a variety of sizes and shapes, ranging in
size from 5.5 x 8 inches to full-size tabloid pages; the most
popular size is four pages of 8.5-x-11-inch sheets. In some
cases, a single 11-x-17-inch sheet is folded to form four 8.5-x-
11-inch pages. All newsletters contain the same basic elements,
described below.

Masthead
The masthead reveals the purpose of the publication. Mast-
heads typically include a name, address, mission statement,
copyright information, subscription rates, name of personnel,
and a telephone number. Some also provide a brief table of
contents.

The masthead should be clean, uncluttered, and graphically
pleasing. The masthead of a newsletter is found on page 1 or 2.
Normally, the name and publication data are printed on page 1
and editorial and subscription information is placed on the
second page.

Nameplate
The typography of a newsletter’s name as it appears on the
cover is the nameplate. The nameplate treatment is inextricably
linked to the way readers perceive a publication.

Nameplates are usually placed at the top of the first page and
are often in large, bold letters. However, nameplates can be
centered, flush left, or flush right. Also, vertical orientation of
the nameplate can draw more attention. Figure 9.1 shows a few
variations using PageMaker’s type and graphics.

Folio
The folio lists the volume and issue numbers and the current
date. It is often printed with the nameplate (fig. 9.2).

A good newsletter conveys
information in a concise
and personal format.

A newsletter masthead
becomes identified with
the publication.

A main value of newsletters
is that they provide specific
information and summarize
that information.
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Table of Contents
Readers appreciate knowing at a glance what a publication
contains. A table of contents on the cover increases readership
by drawing attention to articles on inside pages. Tables of
contents are often titled “Inside this issue” or “Featured this
month” and are prominently featured on the first page. They
are graphically set off in boldface, italic type, by shading, or by
a border (fig. 9.3).

Fig. 9.1. Different positions and variations of the nameplate.
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Lorem ipsum
dolor sit amet,
consectetuer
adipiscing elit, sed
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dolore magna
aliquam erat
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suscipit lobortis
nisl ut aliquip ex
ea commodo
consequat.  Duis
autem vel eum
iriure dolor in
hendrerit in
vulputate velit
esse molestie
consequat, vel
illum dolore eu
feugiat nulla
facilisis at vero
eros et accumsan
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dignissim qui
blandit praesent
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delenit augue duis dolore te feugait
nulla facilisi.  Lorem ipsum dolor sit
amet, consectetuer adipiscing elit,
sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.  Ut wisi enim
ad minim veniam. quis nostrud
exerci.

Duis autem vel eum
iriure dolor in
hendrerit in vulputate
velit esse molestie
consequat, vel illum
dolore eu feugiat nulla
facilisis at vero eros et.

Spring Brings Joy
Ut wisi enim

Pd minim
veniam, quis

Mostrud
exerci tation

Cllamcorper

Outdoor Fun
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat
volutpat.  Ut wisi enim ad minim
veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat.
Duis autem vel eum iriure dolor in
hendrerit in vulputate velit esse molestie
consequat, vel. illum dolore eu feugiat
nulla facilisis at vero eros et accumsan.

Duis
autem vel
eum iriure
dolor in
hendrerit
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Autem
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tation ullamcorper suscipit
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dolor in hendrerit in

 Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,
sed diam nonummy nibh
euismod

Lorem ipsum dolor sit
amet, consectetuer
adipiscing elit, sed diam

nonummy nibh euismod
tincidunt ut laoreet dolore
magna aliquam erat volutpat.
Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
vulputate velit esse molestie
consequat, vel illum dolore eu
feugiat nulla facilisis at vero
eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi.  Lorem ipsum dolor sit
amet, consectetuer adipiscing
elit, sed diam nonummy nibh
euismod tincidunt ut laoreet
dolore magna aliquam erat.

Dignissim

 Quis
Nostrud

Vel Illum
Dolore

Duis autem vel eum iriure dolor
in hendrerit in vulputate velit
esse molestie consequat, vel
illum dolore eu feugiat nulla
facilisis at vero eros et
accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi. Nam liber tempor cum
soluta nobis eleifend option
congue nihil imperdiet doming
id quod mazim placerat facer
possim assum.  Lorem ipsum
dolor sit amet, consectetuer
adipiscing elit.Ut wisi enim ad minim

veniam, quis nostrud
exerci tation

ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
vulputate velit esse molestie
consequat, vel illum dolore eu
feugiat nulla facilisis at vero
eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi.
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed
diam nonummy nibh euismod.

Duis autem vel eum
iriure dolor in
hendrerit in vulputate

velit esse molestie consequat,
vel illum dolore eu feugiat
nulla facilisis at vero eros et
accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue.
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Headlines
One of the most important features of the newsletter is its
headline. The size and style of type, the amount of white space,
and the placement in relation to the article are all important
considerations.

Headlines serve two fundamental purposes: letting readers
know what is in the story and capturing the interest of readers.
Headlines can span the entire width of a page, or they can
occupy several lines within a column.

Headlines typically are placed above the articles they intro-
duce. However, they can be placed next to the article as well
(fig. 9.4).

Fig. 9.2. Folios.

Fig. 9.3. Different positions of the table of contents (Inside).

Avoid capitalizing every
word of a headline.
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nulla facilisi.  Lorem ipsum dolor sit
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Duis
autem vel
eum iriure
dolor in
hendrerit
in.

Autem

Inside



Desktop Publishing for Educators: Using PageMaker154

Subheads
Subheads provide a transition between headlines and text.
Subheads maintain the reader’s momentum by breaking long
blocks of text into small segments to enhance readability. Also,
they provide an opportunity for readers to skim a page to find
out what is in an article (fig. 9.5).

Fig. 9.4. Headline placement.

Subheads should be
graphically distinct from
headlines.

Fig. 9.5. Subheads.

Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat.

Ut wisi enim ad minim
veniam, quis nostrud exerci
tation ullamcorper suscipit

Duis autem vel eum iriure
dolor in hendrerit in

 Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,
sed diam nonummy nibh
euismod

Lorem ipsum dolor sit
amet, consectetuer
adipiscing elit, sed diam

nonummy nibh euismod
tincidunt ut laoreet dolore
magna aliquam erat volutpat.
Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
vulputate velit esse molestie
consequat, vel illum dolore eu
feugiat nulla facilisis at vero
eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi.  Lorem ipsum dolor sit
amet, consectetuer adipiscing
elit, sed diam nonummy nibh
euismod tincidunt ut laoreet
dolore magna aliquam erat.

Dignissim

 Quis
Nostrud

Vel Illum
Dolore

Duis autem vel eum iriure dolor
in hendrerit in vulputate velit
esse molestie consequat, vel
illum dolore eu feugiat nulla
facilisis at vero eros et
accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi. Nam liber tempor cum
soluta nobis eleifend option
congue nihil imperdiet doming
id quod mazim placerat facer
possim assum.  Lorem ipsum
dolor sit amet, consectetuer
adipiscing elit.Ut wisi enim ad minim

veniam, quis nostrud
exerci tation

ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
vulputate velit esse molestie
consequat, vel illum dolore eu
feugiat nulla facilisis at vero
eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue
duis dolore te feugait nulla
facilisi.
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed
diam nonummy nibh euismod.

Duis autem vel eum
iriure dolor in
hendrerit in vulputate

velit esse molestie consequat,
vel illum dolore eu feugiat
nulla facilisis at vero eros et
accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue.
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dolor in hendrerit in

 Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,
sed diam nonummy nibh
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adipiscing elit, sed diam nonummy nibh euismod tincidunt
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minim veniam, quis nostrud exerci tation ullamcorper suscipit
lobortis nisl ut aliquip ex ea commodo consequat.  Duis autem vel
eum iriure dolor in hendrerit in vulputate velit esse molestie
consequat, vel illum dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent luptatum
zzril delenit augue duis dolore te feugait nulla facilisi.  Lorem
ipsum dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam
erat.
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Dolore
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veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut aliquip

ex ea commodo consequat.  Duis autem vel eum iriure dolor in
hendrerit in vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto
odio dignissim qui blandit praesent luptatum zzril delenit augue
duis dolore te feugait nulla facilisi.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod. tincidunt ut laoreet dolore magna
aliquam erat volutpat.  Ut wisi enim ad minim veniam, quis
nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip
ex ea commodo consequat.  Duis autem vel eum iriure dolor in
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You can then edit them,
compose the newsletter,
and transmit it to the

printing site. Alternatively, the
newsletter could be published
electronically, meaning that
people read it on their own
computers as soon as it is made
available. In fact, NewsNet of
Bryn Mawr, Pennsylvania,
offers hundreds of newsletters
in online form (see chapter 8).

Writing Style

It is appropriate to begin with
principles that pertain to the use
of language since most docu-
ments consist primarily of words.
Figure 6-1 lists some guidelines
for writing sentences. The read-
ability of a document that follows
these rules will be much higher
than one that doesn’t.

• Write short sentences.
• Use the active voice.
• Use personal pronouns.
• Use action verbs and avoid

nouns created from verbs.

Copyright © 1996
Editor:

Reza Azarmsa
Managing Editor:

Anna Azarmsa
Phone (800) 111-2222

• Do not insert excess infor-
mation into a sentence.

• List conditions separately.
• Avoid multiple negatives.
• Avoid deletion of connect-

ing words.

Technology

Avoid unnecessary
and difficult words

Style checkers can help identify
parts of a document where the
writing needs improvement. A
readability index for each sen-
tence  in a document indicates
which sentences are cumbersome
and need rewriting. More ad-
vanced style checkers (not
commercially available yet) can
provide specific advice about
how to rewrite a sentence, usually
producing rewritten versions for
the author’s/editor’s selection.

Continued on page 13
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"Avoid multiple
negatives"

Advantages of
Desktop Publishing

You can then edit them,
compose the newsletter,
and transmit it to the printing site. Alternatively,

the newsletter could be published electronically, mean-
ing that people read it on their own computers as soon as
it is made available. In fact, NewsNet of Bryn Mawr,
Pennsylvania, offers hundreds of newsletters in online
form (see chapter 8).

It is appropriate to begin with principles that pertain to the
use of language since most documents consist primarily of
words. Figure 6-1 lists some guidelines for writing sen-
tences. The readability of a document that follows these
rules will be much higher than one that doesn’t.

• Write short sentences.
• Use the active voice.
• Use personal pronouns.
• Use action verbs and avoid nouns created from verbs.
• Do not insert excess information into a sentence.
• List conditions separately.
• Avoid multiple negatives.
• Avoid deletion of connecting words.

Style checkers can help identify parts of a document where
the writing needs improvement. A readability index for
each sentence  in a document indicates which sentences are
cumbersome and need rewriting. More advanced style
checkers (not commercially available yet) can provide
specific advice about how to rewrite a sentence, usually
producing rewritten versions for the author’s/editor’s
selection.

Advantages of
Desktop Publishing

Writing Style

Avoid unnecessary
and difficult words
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Byline
The byline is the name of the author of an article. It can be
placed at the start or the end of an article. Often, an author’s
background credentials are provided at the end of a story.
Figure 9.6 shows the anatomy of a page.

Fig. 9.6. Page anatomy.

D       esktop publishing offers
many advantages over the tradi-
tional printing process. Even
though the initial costs of desktop
publishing hardware and software
are high, it actually saves money.
In educational settings this is prob-
ably the case, especially when the
time that the teacher and students
are putting in to set up the layout
is “free.”  Usually, the sense of
accomplishment that comes with
the finished product and the flex-
ibility that comes with the print-
ing process are enough to justify
that time.  There are some poten-
tial benefits to desktop publish-
ing:Picture

Bleed Art, a
photo

Stick-Up
Cap

Wraparound Text

Outside Margin,
the space between the
outside trim and the text

Byline, the author’s name
Advantages of
Desktop Publishing

Headline

Page 1

Caption

Folio, the page
number

Inside Margin, the space
between the binding edge of
the page and the text

Subhead

Top Margin, the distance from the top trim
to the top of the text area

Bottom Margin

by Reza Azarmsa, Ed.D.

Advantages of
Desktop Publishing ......... 1

Time Saving ...............1

Better Appearance ..... 2

More Control ............. 3

Better Design ............. 4

Electronic ...................4

Distribution.................5

Contents

• Reduced typesetting time and
costs.

• Better-looking publications,
which improves readability,
credibility, and prestige.

• More control over the publish-
ing process.

• Increased convenience to de-
signers.

• Increased cooperation among
students.

• Possibility for electronic dis-
tribution.

Time Saving
Reduced typesetting time and
costs are very tangible benefits of
desktop publishing.  Because
word processing and page com-
position programs allow you to
directly create and lay out your
documents, there is no need for a
manual typesetting step.  This
eliminates typesetting costs and
time.
Type-
setting
can
often
take
time.

Alley, or gutter, the space
between columns
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Good design establishes a
balance between unity and
contrast.

Pic

Nameplate

TOC

Pic

Nameplate

TOC

Fig. 9.7. Preparing different sketches provides more choices and alternatives.

Planning a Newsletter
Planning is an essential step in designing a newsletter. As with
other desktop publishing projects, first define your goals and
limitations. You need to establish the overall look you want to
create and to consider any restrictions that will limit your
choices.

You should specify the size of the newsletter. Most newsletters
tend to be printed on a vertical 8.5-x-11-inch page. Of course,
you can consider using a different newsletter format. You
might plan your newsletter to be a vertical, legal-size format or
a horizontal format.

Another consideration involves choosing black-and-white or
color printing. If you decide to use color, how many colors will
you use? Cost of printing is a major factor in determining
black-and-white versus color in a newsletter. One alternative is
preprinting a second color of ink for your newsletter’s name-
plate. Another alternative is to use different ink colors on
paper.

After the initial planning is completed, prepare rough sketches
of the newsletter (see fig. 9.7). Drawing sketches provides you
with an opportunity to examine different approaches and
discard those that do not work. You can quickly make head-
lines larger or smaller, try out different column arrangements,
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and test alternative ways of placing visuals on a page.
In this stage, you can determine the grid for your newsletter,
specify white spaces, determine side margins as well as column
margins, and decide on picture placement and pull-quote
locations.

Copyfitting
One of the most difficult jobs in creating a newsletter is deter-
mining how much publication space your copy requires, or
determining in advance how much you have to write to fill a
certain space.

You need to know how much space each article will take. To
find out, first measure the available space in column inches.
(This refers to the vertical space the copy will require in the
final publication.)

With the article file loaded in your word processor, first ensure
that the article is in its final form for placement in the Page-
Maker program. The main headline should be stripped out so
that it can be placed separately. The first line should start at the
top of the page. All subheads should be set exactly as they will
appear in the final publication, with the style and size already
selected.

The second step is to create a column the same width as your
body-copy columns and 6 inches high. Place the file in this
column.

Third, count the number of words in your copy, using the
word-count feature in your word processing program.

Fourth, place the word processed file consisting of sentences
and paragraphs in your previously created column and format it
the same as your copy.

Fifth, divide the number of words by 6—the number of column
inches in a column. The resulting figure will be the number of
words that will fit in each column inch.

Copyfitting helps you write
more efficiently and gives
your student writers param-
eters so they can prepare
the right amount of copy to
fit available space.
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Copyfitting with Leading
PageMaker allows control of vertical spacing, or leading. This
is done as text is being placed from a word processed docu-
ment. If you are changing the leading as you place an article in
the publication, your copyfitting estimate will be affected.
Using different leading in text layout affects the copyfitting
process (fig. 9.8).

Pulling It All Together
The publication you will create here is a four-page newsletter
printed on both sides of two 8.5-x-11-inch sheets. The remain-
der of this chapter will guide you through the layout of the first
two pages of the newsletter. You will learn how to create
master pages and a nameplate, to insert articles, boxes, boxed
elements such as a table of contents, and graphics, and to wrap
text around a graphic.

Initial Page Layout
1. Open the PageMaker program. Select New from the File

menu. The Document setup dialog box displays (fig. 9.9).

Fig. 9.8. The same block of text with different leading alters the column length.

The butterfly, in the heart of the
pure blue sky, heard the roar of the
green valley’s waterfall and its
hunger for sleep on an unknown
wildflower was making its wings
numb and heavy.

The valley, with its towering
waterfall and flower-strewn cliffs,
grew small beneath its wings. It felt
the heavy load of the water’s spray,
carried by the gay breeze, on its
wing. It saw the world like a green
and swelling wave.
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For the purpose of this newsletter, accept the following page
setup items as is:

Page: letter size
Page dimension: 8.5 by 11 inches
Page orientation: Tall
Start page number: 1

2. Place the Pointer on the box next to Number of pages
and drag across the box; then type 4, because the total number
of pages for this newsletter will be four. The newsletter will be
double-sided, so leave the box next to this option selected.
Deselect or deactivate the box next to Facing pages by clicking
the Pointer in the box.

To change the inside margin (the space between the binding
edge of the page and the text), place the Pointer on the box next
to Inside and drag across to highlight the box; then type 0.75.
Click OK to display the publication area.

Setting Up the Master Page
As discussed before, master pages can hold text, graphics, and
column and ruler guides that are repeated on all the publication
pages in a document. Positioning these items on master pages

Fig. 9.9. The Document setup dialog box.
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rather than on each page avoids the potential for error associ-
ated with retyping or repositioning elements. See the master
page icon located at the lower left of the screen. The master
page for odd numbers is marked R and the master page for
even numbers is marked L.

1. Place the Pointer on the master page icon for odd num-
bers (R) and click the mouse button.

2. To set the columns, select Column guides from the
Layout menu. The Column guides dialog box appears. When
the Number of columns box is selected, type 3 and click OK.
Repeat the same procedure for the left master page.

3. To set the ruler guides for positioning and alignment of
elements, place the Pointer on the vertical ruler and drag out a
ruler guide. Place the guide at 7.13 inches on the horizontal
ruler. Drag another ruler guide out and place it at 0.17 inch on
the horizontal ruler. Place the Pointer on the horizontal ruler,
drag out a ruler guide, and position it at 10.2 inches on the
vertical ruler. Repeat the same procedure for the left master
page.

4. To establish automatic page numbering on the right
master page, select the Text tool from the Toolbox. Place the
I-beam cursor at 10.8 inches on the vertical ruler and 7.13
inches on the horizontal ruler and click. Press the Ctrl-Shift-3
keys at the same time. After you release the keys, a page-
number placeholder, RM, will appear for the right master page.
Then place the I-beam cursor at 10.8 inches on the vertical
ruler and 0.17 inch on the horizontal ruler. Press the Ctrl-Shift-
3 keys at the same time. Then release the keys. A page-number
placeholder, LM, will appear.

The page-number placeholder that appears on the master page
will be replaced by the actual page number on each page in the
newsletter. The typeface and type style of the page number can
be altered by using text commands.

Framing the Pages
In this design, the newsletter looks better if you frame the print
area.

Anything you add to a
master page automatically
appears on every corre-
sponding (left or right)
page in the document.

Master page icon

The measurement system
for this practice is set at
Inches Decimal in the
Preferences options on the
File menu. In this system,
each inch has 20 tick
marks (each is .05 inches).
For example, 2.10 inches
refers to 2 inches plus 10
tick marks.
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Drawing Lines
1. Select  Stroke from the Element menu and choose Hairline.
2. Select the Square-corners tool from the Toolbox. Posi-

tion the midpoint of the crossbar cursor on the intersection of
the upper left corner margin guides. Hold down the mouse
button while you draw a box to cover the entire margin at 0.15
inch on the horizontal ruler and 0.15 inch on the vertical ruler
(fig. 9.10).

3. Repeat the process for the left master page.

Drawing the Box and Adding Reverse Text
On the top of each page will be a filled solid black box contain-
ing the name of the newsletter (in this case, “Newsletter”) and
the date of publication.

1. Select the Square-corners tool from the Toolbox. Place
the crossbar cursor on the intersection of the upper left mar-
gins, at 0.15 inch on the horizontal ruler and 0.15 inch on the
vertical ruler. Hold down the mouse button and draw a box
across the width of the page to 1.2 inches on the vertical ruler
and 7.15 inches on the horizontal ruler. While the box is acti-
vated, select Stroke from the Element menu and choose None.
Select Fill from the Element menu and choose Solid.

A ruler guide dragged out
Fig. 9.10. A framed page.

To avoid selecting ruler
guides while attempting to
select other objects, press
the Ctrl key or select the
Lock guides command
from the Guides and rulers
option in the Layout menu.



Desktop Publishing for Educators: Using PageMaker162

2. To place reverse type in the box, select the Text tool
from the Toolbox, place the I-beam cursor on the black box,
and click. Select Type style from the Type menu and choose
Bold, Italic, and Reverse. Choose each item separately. Type:

Newsletter

3. Press the Tab key several times and then type:

Spring 1996 (or current date)

4. Select the Pointer from the Toolbox and click on the text
block you just typed. Drag the text to the ruler guides and
center it on the black box (fig. 9.11).

Completing Page 1
The first page of this newsletter contains the nameplate, folio,
headlines, photographs, table of contents, body copy, rules, and
ruler guides. Normally, the first page of a newsletter contains
many layout items. It is helpful to turn off some of the master
page items.

Fig. 9.11. The reversed text.
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1. Select Display master items on the View  menu to deacti-
vate the master page items on the first page. The checkmark
displayed next to Display master items is removed. Except for
the ruler guides, other items disappear.

2. For easier text and graphics placement, drag out several
ruler guides from the horizontal ruler and position them as
follows:

At 1.14 inches on the vertical ruler
At 1.16 inches on the vertical ruler
At 2.2 inches on the vertical ruler
At 2.5 inches on the vertical ruler
At 2.10 inches on the vertical ruler
At 3.17 inches on the vertical ruler
At 6.6 inches on the vertical ruler
At 6.14 inches on the vertical ruler
At 7.4 inches on the vertical ruler
At 7.12 inches on the vertical ruler

The page should look like figure 9.12.

Ruler guides are
nonprinting lines on the
page that you drag out of
the vertical and horizontal
rulers. Position ruler
guides anywhere on the
page to help you align text
and graphics.

Fig. 9.12. The first page with ruler guides.
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3. To prevent accidentally moving the ruler guides select
Lock guides from the Guides and rulers on the Layout menu. A
checkmark next to the option indicates the locked position. To
unlock the ruler guides, select Lock guides again.

Creating the Nameplate
The nameplate characterizes the identity of a newsletter and
affects the way readers perceive the publication. Therefore, you
want to design a simple yet appealing nameplate. In this prac-
tice, the nameplate is created with Avant Garde, a sans serif
typeface, 60 point, bold, and italic.

1. Select the Text tool from the Toolbox. Position the
I-beam cursor on the middle column at 1.14 inches on the
vertical ruler and click.

2. Select Actual size from the View option on the Layout
menu for accurate typing. Then type:

Newsletter

3. Highlight the text and choose Bold and Italic from the
Type style option in the Type menu. Then, select Size from the
Type menu; choose 60 (choices are preselected for this ex-
ample). The text block wraps around the next lines.

4. Select the Pointer from the Toolbox. Place the Pointer
anywhere on the text block and click. Text handles appear.
Position the Pointer on the lower right text handle, hold down
the mouse button, and drag the text handle across the last
column. When the mouse button is released, the text block
stretches across the last column.

5. From the Type menu select Alignment and choose Align
right. You may need to adjust the right justification and reposi-
tion the text block.

Onscreen, the last character seems to exceed the margin line.
This is caused by the italic type style, but when it is printed, it
will be correct (fig. 9.13).

Nameplates remain
unchanged from issue to
issue, so it pays to devote
a lot of care to their
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Draw a solid box under the nameplate and add text.

1. Select the Square-corners tool from the Toolbox. Posi-
tion the crossbar cursor on the first column at 1.16 inches on
the vertical ruler and click.

2. Draw a box to cover all three columns to 2.2 inches on
the vertical ruler.

3. Select Fill from the Element menu and choose Solid. To
place text over the black box, select the Text tool from the
Toolbox and place the I-beam cursor on the box in the left
column and click.

4. Select Reverse, Bold, and Italic from the Type style
option in the Type menu. Type:

No. 1, Vol. 2

5. Select the text block with the Pointer and move it to the
right to 0.17 inch on the horizontal ruler.

6. Select the Text tool from the Toolbox. Place the I-beam
cursor on the right column in the black box, click, and type:

Spring 1996 (or current date)

The text you just typed should appear reverse, bold, and italic.
If not, select these options from the Type style option in the
Type menu.

7. Highlight the text. Select Alignment from the Type menu
and choose Align right.

8. Select the text block with the Pointer and move it to the
left to match the ruler guide located at 10.3 inches on the
horizontal ruler.

Fig. 9.13. The nameplate.
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Finishing the First Page

 Entering and Formatting the Headline
1. Select the Text tool from the Toolbox. Place the I-beam

cursor in the left column at 2.10 inches on the vertical ruler,
click, and type:

Spring Season Brings Joy

2. Highlight the text block. From the Type menu. select
Font and choose Avant Garde (if not available, choose
Helvetica instead ); select Size and choose 30; and select Type
style and choose Bold.

3. To stretch the headline across two columns, select the
headline with the Pointer, place the Pointer on the lower right
text handle, hold down the mouse button, and drag the text
handle to the next column. The left margin of the headline
should start from the ruler guide at 0.17 inch. Select the text
block with the Pointer and readjust it (fig. 9.14).

This page contains the main article, a poem, a two-column
picture, and the table of contents.

Drawing a Placeholder for the Picture
1. Select the Square-corners tool and place the crossbar

cursor at 0.17 inch on the horizontal ruler and 7.12 inches on
the vertical ruler.

2. Hold down the mouse button and drag to cover two
columns at 10.2 inches on the vertical ruler.

3. Select Fill from the Element menu and choose 40%.

Fig. 9.14. The headline.
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Adding the Table of Contents
For a better effect, you may create the table of contents on a
10% screened box. To achieve this, follow these steps:

1. Select the Square-corners tool from the Toolbox and
place the crossbar cursor on the third column at 6.6 inches on
the vertical ruler.

2. Hold down the mouse button and drag to draw a box.
The bottom of the box should reach the ruler guide at 10.3
inches on the vertical ruler and the right side at 7.13 inches on
the horizontal ruler.

3. Select Fill from the Element menu and choose 10%.

To draw a black box for a reverse title:

1. Select the Square-corners tool from the Toolbox, place
the crossbar cursor at 6.6 inches on the vertical ruler and 5.10
inches on the horizontal ruler (on column guide), and hold
down the mouse button.

2. Draw a box to 6.12 inches on the vertical ruler and 7.13
inches on the horizontal ruler.

3. Select Fill from the Element menu and choose Solid.
4. Select the Text tool from the Toolbox, place the I-beam

cursor on the black box, and click.
5. From the Type style option in the Type menu select Bold

and Reverse.
6. From the Size option in the Type menu choose 18  and

type:

Contents

7. Highlight the text and choose Align center from the
Alignment option in the Type menu.

8. Divide the table of contents area into sections for each
topic, using the Perpendicular-line tool.

Adding the Main Article
To separate the main article from the poem (or a second article),
choose the Perpendicular-line tool from the Toolbox, place the
crossbar cursor at 5.1 inches on the horizontal ruler and 2.5
inches on the vertical ruler, and draw a line to 10.5 inches on
the vertical ruler.
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To import the text, you may use the Text frame tool.

1. Select the Rectangular Text frame from the Toolbox.
2. Place the cross-bar cursor on the first column at 3.17

inches on the vertical ruler and draw a box to the size of the
column down to 7.4 inches on the vertical ruler.

3. Repeat the same procedure to draw a text frame on the
second column.

4. Select the first text frame, if is not already selected.
5. Select Place from the File menu. Choose the lorem.txt

file from the DataDisk that accompanies this book and click
OK.

6. Click OK on Text-only import filter, v1.5 dialog box. The
imported text covers the entire text frame.

7. To continue the text in the next column, click the Pointer
on the lower windowshade handle. A thread icon  appears.
Place the loaded icon on the second column and click the
mouse button. The text flows into the second text frame.

8. Highlight column one and column two using the Text
tool.

9. Select Alignment from the Type menu and choose Justify.

Adding the Poem
The third column is suitable for a short article or poem.

1. Select the Text tool from the Toolbox, position the
I-beam cursor on the third column at 2.5 inches on the vertical
ruler, and click.

2. From the Type menu, select Font and choose Avant
Garde (Helvetica if Avant Garde is not available); select Size
and choose 14; and select Type style and choose Bold. Type:

Spring Fever

3. Select the Rectangular text frame from the Toolbox.
Place the cross-bar cursor on the third column at 3.2 inches on
the vertical ruler and 5.11 inches on the horizontal ruler.

4. Click and draw a text frame to 6 inches on the vertical
ruler and 7.13 inches on the horizontal ruler.

5. To import text, select Place from the File menu. Choose
the poem.txt file from the DataDisk and click OK.

6. Click OK on Text-only import filter, v1.5 dialog box. The
text flows into the frame.
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7. From the Toolbox, select the Text tool and highlight the
text block.

8. Select Bold and Italic from the Type style option in the
Type menu. Bold and italic style gives a sense of elegance to
the short poem. Use the same style for headings in the table of
contents.

9. To separate this column from the main article, draw a
vertical line. Select the Perpendicular-line tool from the
Toolbox. Place the crossbar cursor at 2.5 inches on the vertical
ruler and 5.9 inches on the horizontal ruler and click.  Hold the
mouse button and draw a line to 10.5 inches on the vertical ruler.
From the Element menu select Stroke and choose Hairline.

When finished, the first page should look like figure 9.15.

Fig. 9.15. The first page of your newsletter.

To add a drop capital to
the text: highlight the
first letter of a
paragraph. Select Drop
cap from PageMaker
Plug-ins in the Utilities
menu. Drop cap dialog
box displays. Specify
the number of drop
lines, then click OK.

To make the text bold and
italic, select the text block
with the Text tool and
choose Bold and Italic from
the Type style in the Type
menu.

No. 1, Vol. 2

Contents

Spring Fever 1

Spring Break 3

Enrollment 4

Spring Season 1

Giraffe Attack 2

A Poem

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,
sed diam nonummy nibh
euismod tincidunt ut laoreet
dolore magna aliquam erat
volutpat.  Ut wisi enim ad
minim veniam, quis nostrud
exerci tation ullamcorper
suscipit lobortis nisl ut aliquip
ex ea commodo consequat.
Duis autem vel eum iriure
dolor in hendrerit in vulputate
velit esse molestie consequat,
vel illum dolore eu feugiat.

Spring Fever

Newsletter

Address 4

Spring Season
Brings Joy
Nature Lover

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,

sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.
Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis nisl
ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
consequat, vel illum dolore eu
feugiat nulla facilisis at vero eros
et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue duis
dolore te feugait.

Duis autem vel eum iriure dolor in
hendrerit in vulputate velit esse
molestie consequat, vel illum
dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit.

Mliber tempor cum soluta
nobis eleifend option

congue nihil imperdiet doming id
quod mazim placerat facer possim
assum.  Lorem ipsum dolor sit
amet, consectetuer adipiscing elit,
sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.  ✦

Spring 1996

Mothers and
Daughters 3
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Completing Page 2
Page 2 contains a long article with a picture in the middle, text
“wrapped” around it, and two pull quotes, one in the first
column and one in the third column.

Placing the Article
The procedures for creating headlines and importing text into
page 2 are the same as for page 1.

1. Select Place from the File menu.
2. Choose the lorem.txt file from the DataDisk and click OK.
3. Click OK on Text-only import filter, v1.5 dialog box.
4. Place the loaded icon on the first column and click.

Adding a Graphic
Positioning a graphic in the middle of the text and wrapping
the text around the shape of the graphic requires a special
procedure.

1. Select Place from the File menu. Choose the giraffe.eps
file from the DataDisk and click OK.

2. Position the loaded icon on the pasteboard and click the
mouse button. Enlarge the giraffe to approximately 4.4 inches
high and 3.8 inches wide. Use the graphic handles to resize and
measure the giraffe.

Wrapping Text Around the Graphic
You are now ready to add a customized text wrap around the
graphic.

1. With the graphic selected, choose Textwrap from the
Element menu. The Textwrap dialog box displays (fig. 9.16).

The pasteboard is the area
on the left and right side of
a publication area.

Fig. 9.16. The Textwrap dialog box.
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2. Select the middle box in Wrap option and the third box
in Text flow options; then click OK.

3. Select the graphic with the Pointer. A dotted boundary
with four handles (four corners) appears around the graphic
(fig. 9.17).

Moving the boundary handles will alter the text flow, but you
need more than four handles to achieve an irregular textwrap.
More handles can be created by placing the Pointer on the
dotted boundary and clicking it once. You can create as many
handles as you want.

4. Click on the handles, hold the mouse button down, and
move the boundary around the shape of the graphic The bound-
ary should adjust around the shape of the graphic as shown in
figure 9.18.

If you place the graphic directly on the text and customize the
text flow, then every time a boundary handle is moved or
corrected, the text reflows to compensate. Pressing the
spacebar while adjusting the graphic boundary will inhibit the
text from reflowing.

Fig. 9.17. The boundary around the graphic.
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5. Position the Pointer on the graphic and hold down the
mouse button until the Pointer changes to a four-headed arrow.
Move the graphic and place it at 3.4 inches to 7.8 inches on the
vertical ruler and 2.10 inches to 5.18 inches on the horizontal
ruler. When you release the mouse button, the text reflows
around the graphic (fig. 9.19).

Fig. 9.18. The adjusted boundary.

Fig. 9.19. The page with the customized wrap.

Options in the Textwrap
dialog box show how the
text will wrap around the
graphic and how far the
text must stay away from
the graphic.
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Wrap Options
Read this part if you are interested in in-depth textwrap. Wrap
options in the Textwrap dialog box indicate whether you wish
the text to flow around the graphic or not. If the first box in the
wrap options is selected, all other boxes in the dialog box
become unusable. In this case, the text ignores the graphic and
runs right over it.

When the middle wrap option box is selected, you must make a
choice about the Text flow options. The first choice causes text
to stop flowing when it reaches a graphic. The second choice
causes the text to jump over the graphic and places a boundary
around the graphic. The third choice causes the text to wrap all
sides of the graphic and to continue to flow below the graphic
icon.

Stand off in inches is a margin for a graphic and controls the
distance from the graphic to the top, bottom, left, and right
edge of the graphic boundary. Enter a value in each box to
determine the stand-off margin. In a customized graphic
boundary, the stand-off options become inactive.

Finishing the Newsletter
The procedures for completing the remaining two pages are the
same as the first pages. The difference is in the particular
design and layout you choose. For instance, page 3 could
contain two graphics (pictures) and two articles. Page 4 could
include a graph, a picture, and an article on the top half, and the
lower half could contain mailing information.

When you are finished with your layout, your newsletter may
look like figure 9.20 on the next four pages. Sample scanned
photos that are not included with the DataDisk are added to
figure 9.20 for illustration purposes.

Customized textwrap is not
selected directly. It be-
comes selected automati-
cally when the graphic
boundary is customized.
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Fig. 9.20a. The finished newsletter, page 1.
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vel illum dolore eu feugiat.

Spring Fever

Newsletter

Address 4

Spring Season
Brings Joy
Nature Lover

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,

sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.
Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis nisl
ut aliquip ex ea commodo
consequat.  Duis autem vel eum
iriure dolor in hendrerit in
consequat, vel illum dolore eu
feugiat nulla facilisis at vero eros
et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit augue duis
dolore te feugait.

Duis autem vel eum iriure dolor in
hendrerit in vulputate velit esse
molestie consequat, vel illum
dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto odio
dignissim qui blandit praesent
luptatum zzril delenit.

Mliber tempor cum soluta
nobis eleifend option

congue nihil imperdiet doming id
quod mazim placerat facer possim
assum.  Lorem ipsum dolor sit
amet, consectetuer adipiscing elit,
sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.  ✦

Spring 1996

Mothers and
Daughters 3
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tiuve tamia queso utage udulc
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isput tatqu aliqu
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uacae ierqu vagas ubesc.

Rpore ibere perqu umbra perqu
antra erorp netra 225at mihif

napat ntint riora intui urque nimus
otoqu cagat rolym oecfu iunto
ulosa tarac ecame suidt mande
onatd stent spiri usore idpar thaec
abies 250sa Imsep pretu tempu
revol bileg rokam revoc tephe
rosve etepe tenov sindu turqu brevt

elliu repar tiuve tamia queso utage
udulc vires humus fallo 275eu
Anetn bisre freun carmi avire
ingen umque miher muner veris
adest duner veris adest iteru quevi
escit billo isput tatqu aliqu diams
bipos itopu 300ta Isant oscul
bifidmquec cumen berra etmii

pyren nsomn anoct reern oncit
quqa anofe ventm hipec

oramo.

Uetfu orets nitus sacer tusag
teliurorp  netra 350at mihif

napat ntint riora intui urque nimus
otoqu cagat rolym oecfu iunto
ulosa tarac ecame suidt mande
onatd stent spiri usore idpar thaec
abies 375sa Imsep pretu tempu
revol bileg rokam revoc tephe
rosve etepe tenov sindu turqu.

Brevt elliu repar tiuve tamia
queso utage udulc vires hu-

mus fallo 400eu Anetn bisre freun
carmi avire ingen umque miher
muner veris adest duner veris
adest iteru quevi escit billo isput
tatqu aliqu diams bipos itopu
cumen berra etmii pyren nsomn
anoc reern oncit quqar anofe
ventm umque miher muner veris
adest duner veris adest iteru quevi
escit billo isput tatqu aliqu diams
bipo.

HiUec oramo uetfu orets nitus sacer tusag teliu

Giraffe Attacks City, Mayor
Declares Emergency

✦

"425ta Isant oscul
bifid mquec"

"Eonei elaur plica
oscri eseli sipse enitu
ammih mensl"

Newsletter Spring 1996



Desktop Publishing for Educators: Using PageMaker176

Fig. 9.20c. The finished newsletter, page 3.

3

    Spring 1996No. 1, Vol. 2

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,

sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.  Ut wisi
enim ad minim veniam, quis
nostrud exerci tation ullamcorper
suscipit lobortis nisl ut aliquip ex
ea commodo consequat.  Duis
autem vel eum iriure dolor in
hendrerit in vulputate velit esse
molestie consequat, vel illum
dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto
odio dignissim qui blandit
praesent luptatum zzril delenit
augue duis dolore te feugait nulla
facilisi.  Lorem ipsum dolor sit
amet, consectetuer adipiscing
elit, sed diam nonummy nibh

Spring Break

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit,

sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat.  Ut wisi
enim ad minim veniam, quis
nostrud exerci tation ullamcorper
suscipit lobortis nisl ut aliquip ex
ea commodo consequat.  Duis
autem vel eum iriure dolor in
hendrerit in vulputate velit esse
molestie consequat, vel illum
dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto
odio dignissim:

• qui blandit praesent
luptatum zzril delenit augue duis
dolore

• te feugait nulla facilisi.
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit, sed
diam

• nonummy nibh euismod
tincidunt ut laoreet dolore magna
aliquam erat volutpat. ✦

Mother and Daughter Day
Created Joyous Results
School Pencrafter

The event brought family together

euismod tincidunt ut laoreet dolore
magna aliquam erat volutpat.  Ut
wisi enim ad minim veniam, quis
nostrud exerci tation ullamcorper
suscipit lobortis nisl ut aliquip ex
ea commodo consequat.

Duis autem vel eum iriure
dolor in hendrerit in

vulputate velit esse molestie
consequat, vel illum dolore eu
feugiat nulla facilisis at vero eros
et accumsan et iusto odio dignissim
qui blandit praesent luptatum zzril
delenit augue duis dolore te feugait
nulla facilisi. Nam liber tempor
cum soluta nobis eleifend option
congue nihil imperdiet doming id
quod mazim placerat facer possim
mklur.  ✦ The troop leader
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napat ntint riora intui que nimus
otoqu cagat rolym.
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Pretu tempu revol bileg
rokam revoc tephe rosve

etepe tenov sindu turqu brevt elliu
repar tiuve tamia queso utage
udulc vires humus fallo 25deu

Anetn bisre freun carmi avire ingen
umque miher muner veris adest
duner veris adest iteru quevi escit
billo isput tatqu aliqu diams bipos
itopu 50sta Isant oscul bifid mquec

Enrollment Hikes for 1996

Four Seasons Sch
oo

l

Four Seasons School
A place to grow

Four Seasons School Enrollment
1995 - 1996

The Principal

✦
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